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RESUMO 

O objetivo deste trabalho foi analisar a fragilidade potencial e ambiental multitemporal do município de Dois 

Irmãos do Buriti – MS para os anos de 1998, 2008 e 2018. Os procedimentos metodológicos fundamentaram-se 

em técnicas de álgebra de mapas e análise multicritério baseadas nas propostas de Ross (1994; 2012) e Bacani et 

al. (2015), levando em conta as variáveis, solo, declividade, pluviosidade, áreas prioritárias para a conservação da 

biodiversidade e cobertura e uso da terra. Os resultados mostraram que a fragilidade potencial do município de 

Dois Irmãos do Buriti constitui-se em sua maioria um nível de muito baixo a médio, totalizando 89,23% do 

território, possuindo uma declividade entre 0 e 6%. A análise multitemporal da fragilidade ambiental revelou a 

redução da estabilidade ambiental e aumento da média fragilidade ambiental, o que evidencia estado de alerta em 

relação à intensificação do uso da terra pelas atividades agropecuárias no município. 

Palavras chave: Geoprocessamento, Fragilidade Ambiental, Dois Irmãos do Buriti. 

 

APPLICATION  OF GEOTECHNOLOGIES FOR THE MULTITEMPORAL 

ANALYSIS OF ENVIRONMENTAL FRAGILITY IN THE MUNICIPALITY OF 

DOIS IRMÃOS DO BURITI – MS 

ABSTRACT 

The aim of this work was to analyze the potential and multitemporal fragility of the municipality of Dois Irmãos 

do Buriti - MS for the years 1998, 2008 and 2018. The methodological procedures were based on map algebra 

techniques and multicriteria analysis based on in the proposals of Ross (1994; 2012) and Bacani et al. (2015), 

taking into account the variables, soil, slope, rainfall, priority areas for biodiversity conservation and land cover 

and use. The results showed that the potential weakness of the municipality of Dois Irmãos do Buriti is mostly a 

very low to medium level, totaling 89.23% of the territory, with a slope between 0 and 6%. The multitemporal 

analysis of environmental fragility revealed a reduction in environmental stability and an increase in the average 

environmental fragility, which shows a state of alert regarding the intensification of land use by agricultural 

activities in the municipality. 

Keywords: Geoprocessing, Environmental Fragility, Dois Irmãos do Buriti. 
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Introdução 

  

Dutra e Silva et al. (2018) citam a localização estratégica do cerrado no centro 

geográfico do país, tendo como destaque a malha viária para o escoamento agrícola, o 

melhoramento genético de espécies adaptadas ao solo e suas planícies que facilitam a 

agricultura e pecuária mecanizada. Fazendo da região um atrativo para empresas e se tornando 

uma grande produtora de commodities. 

Nesse contexto, destaca-se o município de Dois Irmãos do Buriti, que se localiza na 

Bacia do Alto Paraguai, na interface do planalto de Maracaju/planície pantaneira, que tem 

acompanho essa tendência de uso da terra regional em um ambiente de extrema importância 

ecológica (BRASIL, 2007), que somado à agropecuária, possui projetos de assentamentos 

rurais (SEMAGRO, 2019) e terras indígenas (OLIVEIRA, 2011). 

Um mapeamento do uso e cobertura da terra realizado no município de Dois Irmãos do 

Buriti – MS revelou que mais de 80% do solo do município é utilizado por pastagens e 

agricultura, e apenas 20% apresenta certo grau de preservação (CHAGAS, 2011). Santos (2019) 

também verificou que a agropecuária se mantem como o setor econômico mais importante do 

município em relação à geração de riqueza, evidenciando a dependência do município ao 

agronegócio.  

O registro e monitoramento das mudanças no uso da terra e cobertura vegetal têm sido 

positivamente impactados pelos avanços tecnológicos nas áreas de sensoriamento remoto e de 

Sistemas de Informação Geográfica (SIG) influenciando de sobremaneira o setor das 

geotecnologias aplicadas a diagnósticos ambientais rápidos, precisos e de baixo custo para a 

gestão de prefeituras municipais.  

 Segundo Paranhos Filho et al. (2016) com o avanço do poder de processamento de dados 

dos computadores e com o advento de softwares livres e gratuitos, nota-se uma redução de 

custos na análise de imagens de satélite, imagens que, por sua vez, tiveram uma queda de custo 

e no caso de imagens Landsat o custo é zero. Deste modo, o uso das geotecnologias no 

mapeamento e análise da fragilidade potencial e fragilidade ambiental no município de Dois 

Irmãos do Buriti, vai possibilitar um estudo de caso com economia de tempo e a análise de uma 

grande área de interesse de forma multitemporal, bem como relacionar os resultados com a 

ocorrência de processos erosivos. 

Com o advento da necessidade de estudar e quantificar a relação entre as atividades 

antrópicas e a questão ambiental, surgiram diversos modelos para a avaliação de fragilidade 

potencial e ambiental, tais modelos permitem quantificar os graus de fragilidade dos ambientes 
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e por sua vez avaliar os produtos gerados com o intuito de subsidiar o poder público na tomada 

de decisões e no planejamento territorial, visando a adequação do uso e ocupação do solo e a 

minimização dos impactos ambientais (MANFRÉ et al., 2013). 

Para entendermos o conceito de Fragilidade ambiental, podemos recorrer a Teoria dos 

Sistemas. Conforme explica Vitte e Santos (1999) um sistema se define como um complexo de 

elementos em interação, interação essa de natureza ordenada. Desse modo, de acordo com a 

dinâmica dos sistemas ambientais, é possível mapear e quantificar suas fragilidades potenciais 

e ambientais. 

Podemos conceituar dois tipos de fragilidade ambiental diferentes, de acordo com 

Kawakubo et al. (2005) existe a fragilidade  chamada potencial – caracterizada pela fragilidade 

natural que uma determinada área está submetida, ou seja, a partir do tipo de solo, declividade 

do relevo, erosividade, erodibilidade, entre outros, onde o local poderá ou não apresentar um 

equilíbrio natural e a fragilidade emergente (ou ambiental) que, além de considerar os elementos 

naturais observáveis na fragilidade potencial, acrescenta o fator humano, que se caracteriza pelo 

uso da terra. 

Desse modo, embora existam vários estudos sobre a temática da fragilidade ambiental 

no país, bem como no estado de Mato Grosso do Sul, o município de Dois Irmãos do Buriti – 

MS ainda não possui esse tipo de mapeamento em nível municipal e de caráter multitemporal. 

Dessa forma, esta pesquisa preenche uma lacuna importante na literatura em escala municipal 

por um lado e por outro, propõe analisar o caráter multitemporal da fragilidade ambiental 

decorrente das mudanças no uso e cobertura da terra relacionando a ocorrência de processos 

erosivos, partindo-se da premissa que a intensificação do uso terra aumenta os níveis de 

fragilidade ambiental.  

 

Localização e Caracterização da Área de Estudo 

 

 O município de Dois Irmãos do Buriti tem uma área de aproximadamente 2.345 km². 

Está localizado na região geográfica intermediária de Campo Grande no Estado de Mato Grosso 

do Sul (IBGE, 2017), no retângulo envolvente das Latitudes 20°8'23.59"S/ 21°2'35.14"S e 

longitudes 55°35'12.43"O/ 55°09'7.21"O (Figura 1). Faz divisa com os municípios de 

Aquidauana ao norte, ao sul com o município de Sidrolândia, e leste com o município de 

Terenos e com o município de Anastácio a oeste. O município pertence à bacia hidrográfica do 

Rio Miranda, que compõe a Bacia do Alto Paraguai. 
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 Segundo os dados do Censo demográfico (IBGE, 2010), o município possuia uma 

população, no último censo, de 10.363 habitantes, já a estimativa para o ano de 2019 é de um 

total de 11.385 habitantes, um aumento de 9.86% em 9 anos, com uma densidade demográfica 

de 4,42 hab/km². As atividades econômicas estão ligadas ao agronegócio e concentradas na 

pecuária (IBGE, 2010). 

 
Figura 1. Mapa de Localização do município de Dois Irmãos do Buriti – MS. 

 

 O município de Dois Irmãos do Buriti – MS possui uma área de terra indígena 

demarcada pela FUNAI que se localiza a sudoeste do município e possui sete aldeias dividindo 

o mesmo território, são elas Água Azul, Barreirinho, Buriti, Nova Buriti, Olho D’Água, 

Oliveira e Recanto. Todas as aldeias são da etnia Terena, segunda maior etnia de Mato Grosso 

do Sul (OLIVEIRA, 2011). 

 Existem quatro assentamentos rurais no município de Dois Irmãos do Buriti – MS, 

Assentamento Marcos Freire, no limite com o município de Anastácio – MS; Santa Amélia, 

Paulo Freire e Piúva 5, sendo que os três últimos citados ficam próximos a área urbana do 

município. 
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Materiais e Métodos 

 

Os procedimentos metodológicos fundamentaram-se em técnicas de álgebra de mapas 

e análise multicritério baseadas nas propostas metodológicas de análise de fragilidade ambiental 

descritas em Ross (1994; 2012) e Bacani et al. (2015), levando em conta as variáveis, solo, 

declividade, pluviosidade, áreas prioritárias para a conservação da biodiversidade e cobertura e 

uso da terra e áreas protegidas (Áreas de Preservação Permanente), segundo a Figura 2.  

 

 
Figura 2. Fluxograma dos procedimentos metodológicos. 

 

O mapa de solo de Mato Grosso do Sul foi obtido em formato shapfile através do site 

do SISLA – Sistema Interativo de suporte ao Licenciamento Ambiental, site esse que é mantido 

pelo IMASUL – Instituto de Meio Ambiente de Mato Grosso do Sul. Para recortar a área de 

interesse foi utilizado o limite do município de Dois Irmãos do Buriti (IBGE, 2017). O mapa 

de solos foi baseado no Macrozoneamento Geoambiental (1989). A classificação dos solos foi 

feita de acordo com o Sistema Brasileiro de Classificação de Solos (SiBCS) – Embrapa (2018), 

pois a classificação obtida no arquivo estava defasada. 

O próximo passo foi a conversão do mapa de solos do formato vetorial para o formato 

raster, para tornar possível a atribuição de pesos para as classes de solos conforme a 

metodologia proposta por Ross (1994), para isso foi utilizado o Software ArcGis/ArcMap® 
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10.5(ESRI, 2018). Foram utilizadas as ferramentas: Arctoolbox>Conversion Tools>To 

Raster>Polygon to Raster. 

Com o arquivo no formato raster foi possível utilizar a ferramenta Reclacify para 

reclassificar a imagem atribuindo a ela os valores com os pesos referente a fragilidade do solo, 

assim, foi obtida o mapa de fragilidade do solo do município. Na Tabela 1 é possível observar 

como os solos foram agrupados em classes e nível de fragilidade referente ao peso que elas 

receberam. 

 

Tabela 1 – Agrupamento de Solos por Nível de Fragilidade. 

Classes de solo Nível de fragilidade Peso 

LEa11/LEa19/LRe3/LRd2/LRa1 Muito baixa 1 

PVd3/PVa10 Média 3 

PVd5/PVd4 Alta 4 

Ra2/AQa7/Rd4/AQa11/AQa6/HGPd6/AQa12/Re4/Re1 Muito Alta 5 

Fonte: Adaptado de Ross (1994). 

O mapa de declividade do Município de Dois Irmãos do Buriti foi obtido através do 

mosaico de duas imagens do RADAR SRTM (TOPODATA/INPE). O Modelo Digital de 

Elevação (MDE) foi recortado conforme a área de interesse, em seguida foi utilizada a 

ferramenta Slope no software ArcGis 10.5 (ESRI, 2018) para a obtenção da declividade em 

porcentagem: Spatial Analyst Tools>Surface>Slope. Após a obtenção do MDE SRTM em 

porcentagem foi possível fazer a reclassificação do mesmo de acordo com as classes de 

declividade propostas pela metodologia de Ross (1994), para isso foi utilizada a ferramenta 

Reclassify do ArcGis 10.5: Spatial Analyst Tools>Reclass>Reclassify. A Tabela 2 como foram 

definidas as classes de fragilidade em função da declividade (ROSS, 1994). 

 

Tabela 2 . Divisão das classes de fragilidade da declividade. 

Categorias Hierárquicas Classes 

1 – Muito Baixa >6% 

2 – Baixa De 6% a 12% 

3 – Média De 12% a 20% 

4 – Alta De 20% a 30% 

5 – Muito Alta >30% 

Fonte: Ross (1994). 

 Para obter o mapa das Áreas Prioritárias para a conservação da Biodiversidade, 

primeiramente foi incluído no ArcGis/Arcmap o Shapefile do levantamento das mesmas 

disponibilizado pelo Ministério do Meio Ambiente – MMA, aprovada pela deliberação 

CONABIO nº 39, de 14 de dezembro de 2005 (BRASIL, 2005), que por sua vez foi baseada no 
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Mapa de Biomas do Brasil elaborado pelo Instituto Brasileiro de Geografia e Estatística (IBGE, 

2004). Após a inclusão do shapefile em ambiente SIG, foi recortada a área de interesse e 

convertido em formato Raster para que pudesse ser reclassificado com o peso de importância 

biológica, conforme a metodologia proposta por Ross (1944), (Tabela 3). 

 

Tabela 3 . Áreas prioritárias para a conservação. 

Importância Biológica Níveis de Fragilidade Peso 

Não Prioritária Muito Baixa 1 

Alta Alta 4 

Extremamente alta Muito Alta 5 

Alta Muito Alta 5 

Fonte: Probio/MMA (2007) apud Félix da Silva e Bacani (2017) – Adaptado de Ross (1994). 

 

 Para o mapa pluviométrico, foram adquiridos os dados pluviométricos entre 1977 e 2006 

de 9 estações meteorológicas, extraídos da Agência Nacional de Águas (ANA, 2018), 

disponibilizados em sua homepage. Para classificar os valores dos pesos, foi utilizada uma 

técnica de interpolação denominada IDW (Inverse Distance Weigted), que calcula os valores 

pelo inverso do quadrado das distâncias, ou seja, o interpolador assume que as feições mais 

próximas têm valores mais semelhantes que as mais separadas (BURROUCH; McDONNELL, 

1998). A seguir, foi feita uma adaptação do valor obtido pela metodologia de Crepani et al. 

(2001), que tem um valor máximo de 3, para a proposta de Ross (1994) que tem o valor máximo 

de 5, por meio de uma regra de 3 simples (Tabela 4). 

 

Tabela 4 . Escalas de Vulnerabilidade/fragilidade. 

Metodologia Crepani et. al (2001) Ross (1994) 

Peso 
3 5 

1,5 2,5 

Fonte: Adaptado de Crepani et al (2001) e Ross (1994). 

 

Para elaborar o mapa de uso da terra do ano de 1998, foram adquiridas duas imagens 

LANDSAT 5, sensor TM, das órbitas ponto 225/74 e 225/75, imageadas em 20 de outubro de 

1998, bandas 3, 4 e 5. Para o ano de 2008, foram adquiridas duas imagens LANDSAT 5, sensor 

TM, das órbitas ponto 225/74 e 225/75, imageadas em 15 de outubro de 2008, bandas 3, 4 e 5. 

Por fim, para o ano de 2018, uma imagem LANDSAT 8, da órbita ponto 225/74, bandas 4, 5, 

6, e 8, datada de 09 de setembro de 2018. As imagens foram baixadas do site do United States 

Geological Survey – USGS. 

Das imagens LANDSAT 5 – TM (1998, 2008), foram realizadas a composição falsa cor 

RGB, associando o R a banda 5, o G a banda 4 e o B foi associado a banda 3. Da imagem 
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LANDSAT 8 – OLI (2018), foi realizada a composição falsa cor RGB, onde o R foi associado 

a banda 6, o G foi associado a banda 5 e o B foi associado a banda 4. Também foi realizado o 

tratamento da imagem com a ferramenta de contraste, para assim as imagens serem recortadas 

usando como máscara o limite do Município. 

 Para realizar a classificação, primeiramente foi necessário fazer a segmentação da 

imagem por regiões, o processo foi feito com a ferramenta de segmentação do Spring 5.5.4 

onde é atribuído um número para similaridade e um número para Área (pixels), a segmentação 

que melhor separou as feições foi a de Similaridade 4 e Área 6, foi utilizado os mesmos 

parâmetros de segmentação em todas as imagens. 

 Após a realização da segmentação, foi aberta a janela de Classificação de imagens, 

selecionada as imagens RGB fusionadas, criado um novo arquivo de contexto por regiões e 

selecionado a arquivo de segmentação. Após isso foi iniciado o treinamento com a aquisição 

de amostras das feições, por conseguinte iniciada a classificação por regiões utilizando o 

Algoritmo Batacharya. 

A delimitação das áreas de preservação permanente foi elaborada de acordo com a 

legislação vigente: Art. 3º, item II e delimitada nos termos do Art. 4° itens I, II, IV, V, VIII e 

IX da Lei nº 12.651, de 25 de maio de 2012 (BRASIL, 2012). Foi adquirido o shapefile com a 

hidrografia de Mato Grosso do Sul (SILVA et al., 2011) e aplicado o método de buffer no 

ArcGis/ArcMap. 

Para que o mapa de fragilidade potencial fosse elaborado foi necessária a aplicação de 

técnica de álgebra de mapas, onde valores para cada classe de mapas foram atribuídas e 

posteriormente ponderadas em ambiente SIG, para isso foram utilizados os valores referente a 

metodologia de Ross (1994;2012). Para tal, foi utilizada a ferramenta Weighted Overlay do 

software ArcGis/Arcmap 10.5, adicionando as seguintes variáveis: Áreas Prioritárias, Solos, 

Pluviosidade e declividade. Após a ponderação das variáveis propostas por Ross (1994), o 

resultado foi convertido em formato vetorial, por meio da ferramenta Raster To Polygon, 

disponível em Conversion Tools>From Raster>Raster to Polygon, para assim ser realizada a 

sobreposição das Áreas de Preservação Permanente (APP) de 50m e 30m, por meio da 

ferramenta Update, disponível em Analysis Tools>Overlay>Update. 

 A fragilidade ambiental foi elaborada através da álgebra de mapas entre o uso da terra e 

a fragilidade potencial do Munícipio, tomando como referência a metodologia de Ross (1994; 

2012). Para a sobreposição ponderada ser possível, foi feita a conversão dos arquivos para o 
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formato raster e também a sua reclassificação. A seguir foi utilizada a ferramenta Weighted 

Overlay, disponível no seguinte caminho: Spatial Analyst Tools / Overlay / Weighted Overlay. 

 

 

Resultados e Discussões 

 

Mapeamento de uso da terra 

 

O mapeamento multitemporal do uso e cobertura da terra do município de Dois Irmãos 

do Buriti – MS revelou as principais mudanças ocorridas entre 1998, 2008 e 2018 (Figuras 3 e 

4). Nos anos de 1998 e 2008, foram obtidas quatro classes temáticas distintas: Agricultura, 

Pastagem, Vegetação Ciliar e Cerrado, tais classes foram agrupadas de modo a facilitar a 

posterior atribuição de peso na reclassificação, por exemplo, não foram consideradas as 

diferentes plantações de culturas na agricultura, tendo em vista que todas possuem o mesmo 

nível de fragilidade de acordo com a metodologia utilizada. 

 
Figura 3. Mapa da ocupação e uso da terra do ano de 1998 (A), Mapa da ocupação e uso da 

terra do ano de 2008 (B). 

 

Ao comparar-se os mapas de uso da terra dos anos de 1998 e 2008 (Figura 3), nota-se 

que a pastagem obteve um crescimento substancial, passando de 33,24% para 54,12% da área, 

evidenciando a substituição da agricultura, que declinou de 10,38% para 5,57%. O mapeamento 

também evidenciou a retirada da vegetação ciliar, que tinha 35,47% da área do município e 

A) B) 
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declinou, no ano de 2008 para 19,91%. Na Tabela 6 observa-se os dados de área e porcentagem 

das classes dos anos de 1998, 2008 e 2018. 

 

 

Tabela 5 . Uso da terra no município de Dois Irmãos do Buriti em 1998, 2008 e 2018 – 

quantificação e porcentagem.  

Uso e 

cobertura 

da terra 

Área 1998 Área 2008 Área 2018 % de 

mudança 

(1998-

2018) 

Grau  

de 

fragili

dade 

Peso 

km² % km² % km² %   

Agricultura 243,11 10,38 130,47 5,57 79,97 3,42 -6,96 Alto 4 

Pastagem 778,22 33,24 1266,9

4 

54,12 1271,56 54,32 +21,08 Médio 3 

Vegetação 

Ciliar 

830,28 35,47 466,02 19,91 386,77 16,52 -18,95 Muito 

Baixa 

1 

Cerrado 489,43 20,91 477,60 20,40 476,33 20,34 -0,57 Baixa 2 

Silvicultura - - - - 126,41 5,40 +5,40 Baixa 2 

Fonte: Adaptado de Ross (1994). 

 

Figura 4. Mapa de Uso da Terra do município de Dois Irmãos do Buriti – MS – 2018. 
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O mapeamento de uso da terra no ano de 2018 (Figura 4) chegou aos seguintes resultados: 

a classe Agricultura ocupou a menor área, totalizando 3,42%, com alto grau de fragilidade, é 

observável um decréscimo na região norte e central do município, porém houve um aumento 

na região sul, impulsionado pelo plantio da soja próximo ao limite entre Dois Irmãos do Buriti 

e Sidrolândia, cabe ressaltar que a agricultura do município é composta basicamente por soja e 

milho. 

A área de Pastagem totalizou 54,32%, com um médio nível de fragilidade, observa-se 

que em 2018 a classe teve a mesma porcentagem que no ano de 2008. A cobertura de pastagem 

é do tipo plantada na região de Cerrado, Brachiara decubens, pois tem um fácil manejo e 

adaptação, além da boa palatabilidade e digestibilidade pelo rebanho (AGRAER, 2019). 

 

Com 16,52% a menor área foi a Vegetação Ciliar, com uma fragilidade muito baixa, 

houve declínio da área nos últimos 20 anos. Porém o município adotou políticas públicas do 

município voltadas para o Meio Ambiente, tal como a criação do Conselho Municipal de Meio 

Ambiente em 2009, que freio o declínio da classe nos últimos 10 anos (DOIS IRMÃOS DO 

BURITI, 2009).As áreas cobertas por Cerrado ocupam a segunda maior área, totalizando 

20,34%, com um nível baixo de fragilidade. Por fim, as áreas classificadas como Silvicultura 

ocupam uma porcentagem de 5,4%, com um nível baixo de fragilidade, é a segunda menor 

classe de uso da terra, porém não menos importante, pois vem crescendo nos últimos anos. A 

Silvicultura destaca-se ao norte do município com o plantio de eucalipto, que vem substituindo 

áreas de pastagem por tal cultura.  

 

Fragilidade Potencial e Ambiental 

 

 Para o mapeamento da fragilidade potencial e ambiental, foram obtidos os mapas que 

subsidiariam a análise e as operações de álgebra em ambiente SIG. Tais mapas foram, mapa de 

solos, declividade em porcentagem, precipitação, áreas prioritárias e APPS. 

 Ao verificar o mapa de solos de Dois Irmãos do Buriti – MS, identificaram-se 18 classes 

de solo (Tabela 1, p. 4). A área urbana, todos os assentamentos rurais e a Terra Indígena Buriti, 

bem como a maior parte do município apresentam solos com fragilidade muito baixa. Destaca-

se a presença de Latossolo Vermelho. 

  Podemos observar que 63,76% da área apresenta declividades menores que 6%, sendo 

considerado de fragilidade muito baixa. A segunda maior classe, com 27,44% da área, foi a de 
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declividade de 6% a 12%, com grau de fragilidade baixa (Tabela 6). A Fragilidade alta ficou 

com uma área de 1,57%, ou seja, entre 20% a 30%. A menor classe foi a muito baixa, com 

apenas 0,96%, com uma declividade maior que 30%. 

 

Tabela 6 .Quantificação das classes de declividade do município de Dois Irmãos do Buriti – 

MS. 

Classes de Declividade Área (km²) Área (%) Grau de 

Fragilidade 

>6% 1491,75 63,76 1-Muito Baixa 

De 6% a 12% 641,92 27,44 2-Baixa 

De 12% a 20% 146,59 6,27 3-Média 

De 20 % a 30% 36,79 1,57 4-Alta 

>30% 22,44 0,96 5-Muito Alta 

Fonte: Dados da pesquisa/Adaptado de Ross (1994). 

 

 A partir dos dados é possível verificar que na maior parte da área do município de Dois 

Irmãos do Buriti - MS predominam as classes muito baixa e baixa, as duas classes somam 

91,20% da área do município, ou seja, a maior parte do município possui relevo plano, com 

exceção das áreas a noroeste, próximo ao limite com o município de Aquidauana, no sul do 

município, próximo ao quilômetro 458 da BR-060 e algumas poucas áreas ao norte. 

 Na área analisada é possível observar que a média anual varia de 1215mm a 1353,41mm 

por ano. O período chuvoso no município dura 9 meses do ano (setembro a maio), possuindo 3 

meses de estiagem (junho e agosto), tais dados foram levados em conta para a elaboração da 

carta de intensidade pluviométrica e posterior combinação dos dados para chegar na carta de 

fragilidade potencial. 

 Quanto as Áreas Prioritárias para a Conservação da Biodiversidade, nota-se que a os 

quatro assentamentos do município encontram-se em áreas não prioritárias. A Terra indígena 

Buriti é considerada como uma área de alta prioridade, a sudeste do município, contendo 7 

aldeias indígenas em seu território. As áreas que correspondem as de alta de muito alta 

prioridade são: Ao norte a Serra de Maracaju, a sudeste uma região de beleza paisagística onde 

se considera o fomento ao ecoturismo, por fim, a sudoeste onde se situa um corredor da Serra 

de Maracaju, área de muitas nascentes e segundo o MMA (2007), há estudos sobre a criação de 

um Parque Nacional. 

 Sobre as APPs mapeadas, nota-se que, apesar da área de vegetação ciliar estar 

diminuindo ao longo das décadas analisadas, ou seja, menos 18,95%, tal diminuição não 

invadiu as áreas de preservação permanente. 
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Figura 5. Combinação de dados de solo (a), declividade (b), pluviosidade (c) e áreas prioritárias 

para a conservação da biodiversidade (d), áreas de proteção permanente (e), originaram a 

fragilidade potencial (f). 
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Como resultado da combinação das variáveis: solo, declividade, pluviosidade, áreas 

prioritárias para a conservação da biodiversidade e Áreas de Preservação Permanente 

caracterizou-se a fragilidade potencial do município de Dois Irmãos do Buriti – MS (Figura 5), 

agrupadas em 5 classes: muito baixa, baixa, média, alta e muito alta, distribuídas espacialmente 

em áreas apresentadas na Tabela 7. 

Tabela 7 . Áreas correspondentes a Fragilidade Potencial do município de Dois Irmãos do 

Buriti – MS. 

Classes de Fragilidade Potencial Área (km²) Área (%) 

1 – Muito Baixa 796,65 34,05 

2 – Baixa 812,68 34,74 

3 – Média 477,98 20,44 

4 – Alta 150,16 6,42 

5 – Muito Alta 101,87 4,35 

Fonte: Dados de pesquisa. 

 

Nota-se que a baixa fragilidade potencial é a maior classe em área ocupada no 

município, com 34,74%; seguido do nível muito baixo, com 34,05%; o terceiro maior nível de 

fragilidade potencial foi a média fragilidade potencial, com 20,44% da área do município. 

Sendo assim, essas três classes somadas equivalem a um total de 89,23% da área do município, 

ou seja, levando em consideração a soma de todos os fatores analisados para gerar a carta de 

fragilidade potencial, verifica-se que considerando apenas os elementos do meio físico natural 

a maior parte de Dois Irmãos do Buriti não possui um elevado nível de fragilidade potencial. 

Esse resultado, se explica, pelo predomínio do solo encontrado na área, Latossolo Vermelho, 

cuja fragilidade é muito baixa e relevo plano, com declividades entre 0 e 6%. 

Com a combinação dos dados de fragilidade potencial (solo, declividade, pluviosidade 

e áreas prioritárias para a conservação da biodiversidade) somadas aos mapas de uso da terra 

dos anos de 1998, 2008 e 2018, identificou-se a fragilidade ambiental referente aos mesmos 

anos (Figura 6). Observa-se a quantificação das classes e a respectiva porcentagem dos anos 

mapeados na Tabela 8. 

Tabela 8. Áreas correspondentes a Fragilidade Ambiental do município de Dois Irmãos do 

Buriti – MS, em 1998, 2008 e 2018. 

Classes de 

Fragilidade 

Ambiental 

1998 2008 2018 % de 

mudança 

(1998-

2018) 
km² % km² % km² % 

1 – Muito Baixa 207,45 8,86 42,21 1,80 86,36 3,69 -5,17 

2 – Baixa 1130,55 48,30 1055,24 45,08 1101,34 47,09 -1,21 

3 – Média 821,13 35,08 1069,46 45,70 993,87 42,49 +7,41 

4 – Alta 78,58 3,36 70,79 3,02 55,61 2,38 -0,98 

5 – Muito Alta 103,14 4,40 103,03 4,40 101,83 4,35 -0,05 
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Figura 6. Mapa de fragilidade ambiental do município de Dois Irmãos do Buriti – MS, dos 

anos 1998 (a), 2008 (b) e 2018 (c). 
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 Analisando os dados dos três anos, nota-se que a fragilidade ambiental muito baixa 

apresentou uma variação no período de 20 anos, no ano de 1998 representava 8,86% da área, 

diminuiu no ano de 2008 representando 1,8% da área de estudo, em 2018 aumentou para 3,69%. 

Tal fato, ocorreu devido a retirada da vegetação natural para uso antrópico, os dados podem ser 

associados com a redução de vegetação ciliar dos anos analisados. 

 A classe de fragilidade ambiental classificada como baixa também sofreu variações, 

representava 48,30% em 1998, caiu para 45,08% em 2008 e subiu no ano de 2018 para 47,09%. 

Também, influenciado pela troca de vegetação natural, para uso antrópico, associado as 

mudanças econômicas ocorridas no município nos últimos 20 anos, quando o município fez 

uma transição para a criação de bovinos, aumentando assim, o plantio de pastagens.  

A classe de fragilidade ambiental média em 1998 representava uma área equivalente a 

35,08%, aumentou consideravelmente em 2008 para 45,69% e regrediu para 42,49% no ano de 

2018. Tal acontecimento, se deu, pois, houve um aumento significativo na pastagem nos 

últimos anos, aumentando de 33,24% em 1998 para 54,79% em 2018. O uso da terra como 

pastagem para criação de gado foi incentivada pela inauguração do frigorífico no município em 

2010 e da organização da Cooperativa de Produtores de Leite – COOPERDIB (ACRISUL, 

2018). 

 As áreas classificadas como sendo de alta fragilidade ambiental e a muito alta não 

variaram muito durante as três datas analisadas. A Alta representava um total de 3,36% em 

1998, foi para 3,02% no ano de 2008 e para 2,38% em 2018. A classe considerada de Muito 

Alta fragilidade ficou praticamente restrita as APPs variando entre 4,41% no ano de 1998, 

4,40% no ano de 2018 e 4,35% no ano de 2018. 

 A redução da classe de alta fragilidade ambiental se deve ao fato de uma pequena 

recuperação da Mata Ciliar, nos últimos 10 anos e a substituição da agricultura temporária em 

áreas de fragilidade potencial alta, por pastagem. Essas melhorias, também coincidem com a 

criação da Lei Complementar nº 05/2009, de 27 de janeiro de 2009, que dispões sobre a Política 

Municipal de Meio Ambiente, que em seu art. 4º, inciso I, versa sobre o incentivo à adoção de 

hábitos, costumes, posturas e práticas sociais e econômicas não prejudiciais ao meio ambiente, 

dentre outros interesses municipais. Também foi criado, com essa lei, o Conselho Municipal de 

Meio Ambiente, que dentre outras funções deve estabelecer normas, padrões, critérios e 

parâmetros de qualidade ambiental, realizar o zoneamento ambiental e o licenciamento e 

revisão de atividades potencialmente poluidoras (DOIS IRMÃOS DO BURITI, 2009). 
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 Desta forma, os resultados do estudo da fragilidade ambiental no município de Dois 

irmãos do Buriti- MS corroboram e agregam-se aos outros estudos realizados no Mato Grosso 

do Sul, pois, assim como os estudos citados, a maior porcentagem da área de estudo está 

classificada com fragilidade baixa e média. Tendo também como fator predominante o uso da 

terra como pastagem e declividades pouco acentuadas. 

 

Conclusão 

 

 A partir da análise dos resultados deste trabalho, conclui-se que, considerando apenas 

variáveis do meio físico-natural, o município de Dois Irmãos do Buriti – MS tem uma 

fragilidade potencial predominante entre muito baixa e média, totalizando 89,23% de seu 

território. A fragilidade potencial baixa foi a maior classe mapeada com 34,74% da área, situada 

em uma região com relevo plano, (declividades entre 0 e 6%), são as áreas mais utilizadas para 

a pecuária e plantio de eucalipto, o que reflete diretamente na fragilidade ambiental.  

 Quanto à análise da fragilidade ambiental dos anos de 1998, 2008 e 2018, notou-se uma 

variação entre as classes que evidenciam uma antropização do uso da terra nos últimos 20 anos, 

principalmente pelo plantio de pasto para a criação de bovinos, a agricultura sendo introduzida 

de maneira mecanizada no sul do município, com o plantio da soja, próximo ao limite com 

Sidrolândia – MS, próximo a BR-060.  

 Apesar do município se manter com mais de 50% de classes de fragilidade baixa e muito 

baixa no ano de 2018, e somado com a média chega-se ao total de 93,27%, se comparado ao 

ano de 1998, houve uma queda das classes de fragilidade muito baixa e baixa. 

 O município não tem altos níveis de fragilidade ambiental alta e muito alta, por causa 

do seu solo, em sua maioria Latossolos, baixas declividades e o uso da terra em sua maioria 

com pastagem, com fragilidade média entre outros usos, com menor fragilidade como o 

eucalipto. 

 O mapeamento de fragilidade potencial e ambiental foi de grande importância para a 

compreensão da dinâmica da área em análise, pois com os graus de fragilidades estabelecidos 

é possível um planejamento por parte dos gestores de forma estratégica. Analisou-se uma 

grande área de interesse, ou seja, toda área do município, utilizando as geotecnologias e com 

economia de tempo e recursos. Por fim, a pesquisa pode ser usada como subsídio para o 

planejamento territorial e pode ser o ponto de partida para o avanço do conhecimento da região 

e outras pesquisas. 
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